Copyright and Trademarks

The BESA Connectivity product and its documentation are copyrighted © 2019 by BESA GmbH. All rights reserved.

BESA® is a registered trademark of BESA GmbH, Graefelfing, Germany.

All other trademarks, brands and product names used in this guide are trademarks of the respective owners.
Table of Contents

1. Notes .......................................................................................................................... 5
2. Intended Use and Intended User ............................................................................... 5
   2.1. Intended Use ........................................................................................................... 5
   2.2. Intended User ........................................................................................................ 5
3. Product Classification and Certification ..................................................................... 6
   3.1. Classification ......................................................................................................... 6
   3.2. Certification .......................................................................................................... 7
4. System Requirements .................................................................................................. 7
5. Disposal Information ................................................................................................... 7
6. Installation and Initial Setup ....................................................................................... 8
   6.1. Before Setup ......................................................................................................... 8
   6.2. Installation ............................................................................................................. 8
   6.3. Initial setup ........................................................................................................... 8
   6.3.1. Connect the BESA Dongle ............................................................................... 8
   6.3.2. Start the Program ............................................................................................ 10
   6.3.3. Specify the BESA Connectivity Data Folder .................................................... 10
7. Introduction .................................................................................................................. 12
   7.1. Features of BESA Connectivity ........................................................................... 12
8. Time-Frequency methods ........................................................................................... 14
   8.1. Complex Demodulation ....................................................................................... 14
   8.2. Wavelet Transform .............................................................................................. 14
   8.3. Frequency sampling ............................................................................................. 15
   8.4. Time sampling ..................................................................................................... 17
   8.5. Cone of influence .................................................................................................. 17
   Notes ........................................................................................................................... 18
9. Connectivity methods .................................................................................................. 20
   9.1. Coherence ............................................................................................................. 20
   9.2. Imaginary Part of Coherency ............................................................................... 21
   9.3. Phase Locking Value ........................................................................................... 21
   9.4. Granger causality-based connectivity measures ................................................... 21
   9.5. Granger Causality ............................................................................................... 22
   9.6. Partial Directed Coherence .................................................................................. 22
   9.7. Directed Transfer Function .................................................................................. 22
10. The Workflow Concept ............................................................................................... 23
11. Elements of the BESA Connectivity Screen ............................................................. 24
   11.1. Workflow Window .............................................................................................. 25
   11.2. Main Window ..................................................................................................... 25
11.3. Information Window ................................................................. 25
11.4. Interaction Window ................................................................. 25
11.4.1. Notes .................................................................................. 25

12. Program Bars ............................................................................. 26
12.1. Title Bar .................................................................................. 26
12.2. Menu Bar ................................................................................ 26
12.2.1. File Menu ........................................................................... 26
12.2.2. Edit Menu .......................................................................... 26
12.2.3. View Menu ......................................................................... 27
12.2.4. Export Menu ...................................................................... 27
12.2.5. Help Menu .......................................................................... 28
12.3. Caption .................................................................................. 28
12.4. Toolbar ................................................................................... 28

13. How to use BESA Connectivity .................................................... 29
13.1. Starting BESA Connectivity ....................................................... 29
13.1.1. Welcome Screen .................................................................. 29
13.2. The Workflows of BESA Connectivity .......................................... 30
13.3. Select workflow – Analysis type .................................................. 30
13.3.1. Notes .................................................................................. 30

14. Workflow: Time-Frequency Analysis ............................................. 30
14.1. Set Project targets .................................................................... 30
14.2. Load data ................................................................................ 31
14.3. Set Parameters ......................................................................... 32
14.4. Perform Calculations ................................................................. 34

15. Workflow: Connectivity Analysis .................................................. 37
15.1. Set Project targets .................................................................... 37
15.2. Load data ................................................................................ 37
15.3. Set Parameters ......................................................................... 39
15.4. Perform Calculations ................................................................. 40
15.4.1. 3D Mode ............................................................................ 42

17. Exporting Images, Video, and Results .......................................... 44
17.1. Exporting Images ..................................................................... 44
17.3. Exporting Video ....................................................................... 45
17.4. Exporting Time-Frequency Analysis Results ............................. 46
17.5. Exporting Connectivity analysis results ....................................... 47

18. File Formats ................................................................................. 48
18.1. The BESA Time-Frequency File Format (*.tfc) .............................. 48
18.2. The BESA Single Trial Time-Frequency File Format (*.tfcs) .......... 49
18.3. The BESA Generic File Format v1.1 (*.generic) ........................... 49
18.4. The BESA Channel Definition File Format (*.elp) ......................... 50
18.5. The BESA Solution File Format (*.bsa) ................................................................. 50
18.6. The BESA Binary Data Format (*.dat) ........................................................................ 51
18.7. The BESA ERP / ERF ASCII Vectorized File Format (*.avr) .......................................... 51
18.8. The BESA Connectivity File Format (*.conn) .................................................................. 51
19. References .................................................................................................................. 53
1. Notes

This user manual is a guide to the research product BESA Connectivity – a stand-alone software program.

The manual introduces the features, workflows, and the Main Windows and dialogs of the BESA Connectivity software. A help function is provided within the software. Press F1 on the keyboard or select menu item Help → BESA Connectivity Help for help.

Before starting to work with BESA Connectivity, please read this user manual carefully.

Please report any suggestions and errors found in this manual via email to feedback@besa.de.

BESA GmbH provides support to all customers who have purchased BESA Connectivity directly from our sales office (sales@besa.de) or through our distributors.

BESA GmbH
Freihamer Str. 18
82166 Gräfelfing - Germany

Support: http://besa.de/contact/support/form.php

2. Intended Use and Intended User

2.1. Intended Use

- BESA Connectivity 1.0 is intended for the Use (MDD 93/42/EEC)
  - For Human Beings
  - And NOT for Animal Beings
- BESA Connectivity 1.0 is a stand-alone software product compatible with personal computers running under a Windows operating system.
- The purpose of BESA Connectivity 1.0 is to assist in the analysis of EEG and MEG data by providing tools for the following analysis steps:
  - Time-frequency analysis
  - Brain connectivity analysis
- BESA Connectivity 1.0 is intended to be run independently of the EEG and MEG acquisition and review programs of other manufacturers.
- BESA Connectivity software is licensed for research use only. It is not allowed to use the BESA Connectivity software directly or indirectly for medical diagnosis and/or treatment of humans.

BESA GmbH is not liable for the use of the software beyond the intended research purpose.

2.2. Intended User

- The intended user is a neuroscience professional with a reasonable knowledge about frequency data generated in neurophysiological recordings of human brain activity. He or she is expected to be literate in the usage of computer programs in the Windows environment.
- BESA Connectivity 1.0 is only to be used by appropriate trained specialist personnel who also have an understanding of English sufficient to enable them to read the User Manual and operate the software.
- The BESA GmbH assumes no liability for unauthorized access to this product or unauthorized use. Children, laymen and patients shall not use the product.
3. Product Classification and Certification

3.1. Classification

According to MDD 93/42/EEC, Annex IX, III, BESA Connectivity 1.0 is a Class I software product for the brain connectivity analysis of EEG / MEG data.

According to safety classifications in DIN/EN IEC 62304:2006/AMD1:2015, BESA Connectivity 1.0 is a Class A product (class A: no injury or damage to health is possible).

It is a pure data analysis software, no physical devices are being controlled or driven by BESA Connectivity 1.0, nor is any active feedback provided to the patient. Any direct physical damage to the subject can therefore be excluded.

Use in a Clinical Environment

a) Definition of Patient Environment

IEC 60601-1-Ed.3.1 - Subclause 3.79 – PATIENT ENVIRONMENT

It is difficult for this standard to define dimensions for the volume in which diagnosis, monitoring or treatment occurs. The dimensions for the PATIENT ENVIRONMENT given in Figure A.9 have been justified in practice.

Figure A.9

b) Please Note: It is the User’s responsibility to ensure the safety of combined medical or medical-&-non-medical-devices particularly when installed in the patient environment (whether in institutes, clinics or practitioners' location).

The user of our product has to ensure that such combination fulfil the same safety condition as a single medical device according to IEC 60601-1.
c) Such combination with any non-medical device establishes an “in-house medical system” – observe the latest Medical Device Operator Ordinance (e.g. MedBetreiberVerordnung, Germany 2016) or your national Operator Laws covered by MDD 93/42/EEC.

d) We recommend you to document / retrace our Software version/updates installed in your facility / network in a MPG-Medizingeräte-Buch (medical facilities book), similar to those needed for Hardware.

e) BESA Connectivity 1.0 does not affect the possibility of using any medical computer within patient environment. BESA GmbH is not liable for any use/installation beyond the defined PC network.

BESA Connectivity is classified with the following codes:

UMDNS code: 17-222 Information System
GMDN: 17-222 Information System
GMDN collective term: CT112 (Software, application program)

3.2. Certification

The CE marking certifies that this product fulfills the essential requirements of the Medical Devices Directive MDD 93/42/EEC.

4. System Requirements

- Operating system:
  - Windows® 10 – 64bit (Touch not supported)
  - Windows® 8.1 – 64bit (Touch not supported)
  - Windows® 7 – 64bit (Touch not supported)

- Processor: Minimum 2 GHz
- RAM: Minimum 4 GB
- Display resolution: Minimum 1280 × 1024 pixels
- Graphics card: OpenGL 2.0 with 16 MB RAM or more

5. Disposal Information

When disposing of the BESA license key and the box, national guidelines on environmental protection must be followed.
6. Installation and Initial Setup

The installation and initial setup of BESA Connectivity must be carried out by an administrator or an experienced technician.

6.1. Before Setup

BESA Connectivity is available as 64-bit program. Please make sure your Windows system supports it prior to the installation. The installation and initial setup of BESA Connectivity must be carried out by an administrator or experienced technical staff.

1. Please insert the installation USB stick into your computer. Browse to the Setups folder. If you have downloaded BESA Connectivity 1.0 from our website, browse to the Downloads folder.

2. Run BESA_Connectivity_1_0_November_2019_Setup_Win_x64.exe

3. Please follow the on-screen instructions.

4. Once the installation is complete, proceed with the initial setup as explained in the following chapter.

6.3. Initial setup

The following section explains the steps for the initial setup of BESA Connectivity. These steps have to be performed only once per installation.

6.3.1. Connect the BESA Dongle

BESA Connectivity is protected by a licensing scheme developed by Gemalto Inc. During the Installation the device drivers for the BESA dongles will be installed automatically.

Connect the BESA dongle to your personal computer or a server machine and proceed with the next step. If required, check for correct installation as described below.

If the dongle is installed correctly, the Windows Device Manager reports three items in the "Universal Serial Bus controllers" section: Sentinel HASP Key, Sentinel HL, and Sentinel USB Key.

The Gemalto Inc. HASP key installer includes the HASP License Manager application.

When this application is running, you should be able to load the Sentinel Admin Control Center by typing http://localhost:1947 in your internet browser. The connected dongle should be displayed there. If you do not see the dongle, please wait a few seconds.
If the dongle is not installed correctly, one of the following message boxes is displayed when the program is started.

The message box on the left can appear for one of the following reasons:

- The BESA dongle is not connected.
  
  Solution: Ensure that the key is accessible in order to run the program.

- USB port is defective.
  
  Solution: Check if the LED is lit on the HASP Protection Key. If not, remove and re-insert. Wait for the operating system to detect the device. If it still does not light up, try another USB port.

- Faulty dongle.
  
  Solution: On rare occasions, the HASP Protection Keys may be faulty. The dongle does not light up in this case and is not detected in the Device Manager. Request a replacement dongle.

The above right message box comes up for one of the following reasons:

- The license manager application that usually resides in C:\Windows\system32\hasplms.exe is blocked by a firewall or an anti-virus application.
  
  Solution: Add C:\Windows\system32\hasplms.exe in the exception list of the anti-virus and firewall applications.

- Port 1947 is blocked by a firewall application.
  
  Solution: Add port 1947 to the exception list of the firewall application.
6.3.2. Start the Program

Start BESA Connectivity using the shortcut created on the desktop or run BESA Connectivity.exe from the BESA → BESA Connectivity 1.0 folder in the Start menu.

First, the Welcome Screen appears. Press Accept to start BESA Connectivity.

6.3.3. Specify the BESA Connectivity Data Folder

As initial configuration step, the BESA Connectivity Data Folder must be specified. This is the folder where BESA Connectivity stores all project and result data to and reads from.

When starting the program for the first time, the following dialog box appears:

The BESA Connectivity Data Folder is pre-selected to Public Users on the local PC (shown above for Windows 10).

Press the OK button if you want to use the pre-selected local folder in Public Users.

Press the Edit button to create your BESA Connectivity Data Folder elsewhere, e.g. on a server.

When the selection is accepted, the following confirmation dialog appears:

Press the OK button.

BESA Connectivity is now configured to start projects.
6.3.3.1. Notes

1. The procedure to define the shared BESA Connectivity Data folder on the server needs to be carried out only once at each PC where you install BESA Connectivity, i.e. when starting the program for the first time.

2. When switching between BESA Connectivity Data folders, it is recommended to leave the tick mark on to update all existing projects in the new BESA Connectivity Data folder.
7. Introduction

7.1. Features of BESA Connectivity

BESA Connectivity provides optimized, user-guided workflows for time-frequency and connectivity analysis of EEG/MEG data. Multiple well-established methods are provided. The program is maximally user-friendly. All analyses are computed automatically with required user-interaction reduced to a minimum. The time-frequency and connectivity values computed in BESA Connectivity can be directly used for scientific reports. The outcomes can be exported also for further statistical analysis. All results are visualized and can be directly used for publications.

BESA Connectivity integrates optimally with data that were analyzed in BESA Research, but it can also process data from other software packages as long as they conform to the BESA Connectivity file format.

BESA Connectivity will automatically identify connectivity patterns between channels / regional sources or dipole sources, which can be visualized using 2D matrices or 3D visualization.

There are two workflows with four work steps each in BESA Connectivity:

I. Time-Frequency Analysis
   1. Set Project targets
      a) Complex Demodulation
      b) Wavelet Analysis (Morlet or Mexican Hat)
      c) Number of Conditions and their names
   2. Load Data
   3. Set Parameters
      Various settings can be adjusted which will set the temporal – frequency resolution of further analysis. Here the user can also exclude individual trials from further analysis and set up low and high cutoff frequencies.
   4. Perform Calculations
      A time-frequency analysis will run. After completing of computation results can be evaluated and exported. When finishing this work step, the project can be saved and re-used for connectivity analysis. It is also possible to export analysis results in ASCII format.

II. Connectivity Analysis
   1. Set Project targets
      a) Coherence (Rosenberg et al., 1989)
      b) Imaginary Part of Coherency (Nolte et al., 2004)
      c) Phase Locking Value (Lachaux et al., 1999)
      d) Granger Causality (Granger, 1969; Geweke, 1982)
      e) Partial Directed Coherence (Baccala and Sameshima, 2001)
      f) Directed Transfer Function (Kaminski and Blinowska, 1991)
   2. Load Data
   3. Set Parameters
      Non-Parametric Method settings can be adjusted here (number of iterations, tolerance and regularization). Also, time-frequency analysis results from the previous workflow can be reviewed here.
4. Perform Calculations

A connectivity analysis will run. When analysis is completed the results can be reviewed for each method that was selected in the first work step. A 3D mode of visualization is also available. Analysis outcome can be saved and re-opened later. It is also possible to export them in ASCII format.
8. Time-Frequency methods

The general approach to analyse event-related EEG/MEG oscillations is based on the decomposition of the EEG/MEG signals into magnitude and phase information for each frequency and to track their changes over time. This procedure is referred to as ‘time-frequency analysis’ and comprises those methods that study a signal in both the time and frequency domains simultaneously.

In BESA Connectivity, two approaches for computing time-frequency decomposition are provided:

- Complex Demodulation is based on the convolution of the EEG/MEG signal with series of sine and cosine waves.
- Wavelet Transform uses series of complex Morlet or Mexican Hat wavelets to extract the magnitude and phase information.

Both methods are described in more detail in the following paragraphs.

8.1. Complex Demodulation

Complex Demodulation (Papp and Ktonas, 1977) is based on the convolution of the EEG/MEG signal with series of sine and cosine waves. For each frequency of interest \( f_0 \) the following steps are performed:

a) The original time-domain signal is multiplied by \( \sin(2\pi f_0 t) \) and \( \cos(2\pi f_0 t) \), respectively. This modulation operation shifts every signal at frequency \( f \) to the difference and sum frequencies \( (f \pm f_0) \) in the frequency domain.

b) The resulting two signals are low-pass filtered to extract the frequency range that was originally centered around \( f_0 \) and was shifted to the low frequency range \( f - f_0 \). Thus, the low-pass cutoff frequency sets half of the width of the frequency band for which the envelope amplitude and phase is computed. Thereby, this filter implicitly defines the resolution in time and frequency.

c) The two output signals of step b) define the real and imaginary part of a complex signal as a function of time. Its magnitude corresponds to half the envelope amplitude and its phase to the compound phase of the filtered frequency band centered at \( f_0 \).

8.2. Wavelet Transform

Like for Complex Demodulation, decomposition of the original EEG/MEG signal time series is based on the convolution with a scaled and translated version of a template function in the time domain. In BESA Connectivity, complex Morlet and Mexican Hat wavelets are provided as template functions.

The complex Morlet Wavelet is described as:

\[
\psi(t) = \pi^{-\frac{1}{4}} \left( e^{i\omega_0 t} - e^{-\frac{1}{2} \omega_0^2} \right) e^{-\frac{1}{2} t^2},
\]

where \( i \) denotes the imaginary unit and \( \omega_0 \) is \( 2\pi \) times the frequency of the unshifted and uncompressed mother wavelet.

The temporal and frequency resolution can be adjusted defining the length of the used wavelets in standard deviations of the implicit Gaussian kernel and the width of the wavelets in number of cycles. ‘Shorter’ wavelets will provide a finer temporal resolution at the expense of a coarser frequency resolution and vice versa.

The Complex Mexican Hat wavelet is formulated as:

Real part:

\[
\psi_{\text{real}}(t) = (1 - (\pi t f_0)^2)e^{-\frac{1}{2}(2\pi tf_0)^2} = (1 - \tau^2)e^{-\frac{1}{2}\tau^2}
\]
Imaginary part:

\[ \psi_{imag}(t) = A \times \left\{ 2 \frac{\tau}{\sqrt{2}} + \sqrt{\pi} \left[ erf_i \left( \frac{\tau}{\sqrt{2}} \right) e^{-\frac{3}{2} \tau^2 (1 - \tau^2)} \right] \right\}, \]

where \( \tau = \pi t f_0 \) with target frequency \( f_0 \). \( A \) denotes a scaling factor and is heuristically chosen to be \( A = 0.54 \) for equal scaling of the real and imaginary part.

A review of using wavelets for EEG/MEG analysis is given by Samar et al. (1999). The complex Mexican Hat wavelet was proposed by Addison et al. (2002).

8.3. Frequency sampling

In complex demodulation, frequency resolution is the same across the spectrum. Thus, the spacing between frequencies is uniform, given by a time-frequency sampling parameter that is adjusted by the user.

A wavelet has a frequency-dependent resolution. For Morlet wavelets, \( \sigma_f \) describes the width of the wavelet in the frequency dimension. It is given by

\[ \sigma_f = \frac{f_{oscil}}{f_0} \]

The full width at half maximum of a Gaussian bell curve is approximately at \( 2.3548 \times \sigma \). According to the Nyquist theorem, it would be sufficient to sample this step width \( 2-3 \) times in order to reconstruct the shape of the resulting data values. In practice, it is assumed that sampling will be uniform in the logarithmically transformed frequency axis, and the sampling rate is fixed to \( 0.8 \times \sigma_{f0} \), where \( f_0 \) is the lowest frequency used. For a frequency range of 1–50 Hz sampled with \( oscil = 5 \), this results in 27 frequencies:

<table>
<thead>
<tr>
<th>Frequency</th>
<th>( \Delta[f_n - f_{n-1}] )</th>
<th>ln(frequency)</th>
<th>( \Delta[ln(f_{n}) - ln(f_{n-1})] )</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>1.16</td>
<td>0.16</td>
<td>0.15</td>
<td>0.15</td>
</tr>
<tr>
<td>1.35</td>
<td>0.19</td>
<td>0.30</td>
<td>0.15</td>
</tr>
<tr>
<td>1.57</td>
<td>0.22</td>
<td>0.45</td>
<td>0.15</td>
</tr>
<tr>
<td>1.83</td>
<td>0.26</td>
<td>0.60</td>
<td>0.15</td>
</tr>
<tr>
<td>2.12</td>
<td>0.30</td>
<td>0.75</td>
<td>0.15</td>
</tr>
<tr>
<td>2.47</td>
<td>0.34</td>
<td>0.90</td>
<td>0.15</td>
</tr>
<tr>
<td>2.87</td>
<td>0.40</td>
<td>1.05</td>
<td>0.15</td>
</tr>
<tr>
<td>3.33</td>
<td>0.47</td>
<td>1.20</td>
<td>0.15</td>
</tr>
<tr>
<td>3.87</td>
<td>0.54</td>
<td>1.35</td>
<td>0.15</td>
</tr>
<tr>
<td>4.50</td>
<td>0.63</td>
<td>1.50</td>
<td>0.15</td>
</tr>
<tr>
<td>5.23</td>
<td>0.73</td>
<td>1.66</td>
<td>0.15</td>
</tr>
<tr>
<td>6.08</td>
<td>0.85</td>
<td>1.81</td>
<td>0.15</td>
</tr>
<tr>
<td>7.07</td>
<td>0.99</td>
<td>1.96</td>
<td>0.15</td>
</tr>
<tr>
<td>8.22</td>
<td>1.15</td>
<td>2.11</td>
<td>0.15</td>
</tr>
<tr>
<td>9.55</td>
<td>1.33</td>
<td>2.26</td>
<td>0.15</td>
</tr>
<tr>
<td>11.11</td>
<td>1.55</td>
<td>2.41</td>
<td>0.15</td>
</tr>
</tbody>
</table>
For the Mexican Hat wavelet,

\[ \sigma_f = \sqrt{2} f. \]

Since this would lead to very few wavelets, the factor is adjusted to

\[ \sigma'_f = \frac{\sqrt{2} f}{4}. \]

With this setting, the frequencies of the same range adjust to 17 frequencies:

<table>
<thead>
<tr>
<th>Frequency</th>
<th>( \Delta[f_n - f_{n-1}] )</th>
<th>( \ln(\text{frequency}) )</th>
<th>( \Delta[\ln(f_0) - \ln(f_{n-1})] )</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.24</td>
</tr>
<tr>
<td>1.28</td>
<td>0.28</td>
<td>0.24</td>
<td>0.24</td>
</tr>
<tr>
<td>1.63</td>
<td>0.35</td>
<td>0.49</td>
<td>0.24</td>
</tr>
<tr>
<td>2.08</td>
<td>0.45</td>
<td>0.73</td>
<td>0.24</td>
</tr>
<tr>
<td>2.66</td>
<td>0.58</td>
<td>0.98</td>
<td>0.24</td>
</tr>
<tr>
<td>3.40</td>
<td>0.74</td>
<td>1.22</td>
<td>0.24</td>
</tr>
<tr>
<td>4.34</td>
<td>0.94</td>
<td>1.47</td>
<td>0.24</td>
</tr>
<tr>
<td>5.54</td>
<td>1.20</td>
<td>1.71</td>
<td>0.24</td>
</tr>
<tr>
<td>7.07</td>
<td>1.53</td>
<td>1.96</td>
<td>0.24</td>
</tr>
<tr>
<td>9.03</td>
<td>1.96</td>
<td>2.20</td>
<td>0.24</td>
</tr>
<tr>
<td>11.53</td>
<td>2.50</td>
<td>2.45</td>
<td>0.24</td>
</tr>
<tr>
<td>14.72</td>
<td>3.19</td>
<td>2.69</td>
<td>0.24</td>
</tr>
<tr>
<td>18.80</td>
<td>4.08</td>
<td>2.93</td>
<td>0.24</td>
</tr>
<tr>
<td>24.01</td>
<td>5.21</td>
<td>3.18</td>
<td>0.24</td>
</tr>
<tr>
<td>30.66</td>
<td>6.65</td>
<td>3.42</td>
<td>0.24</td>
</tr>
<tr>
<td>39.15</td>
<td>8.49</td>
<td>3.67</td>
<td>0.24</td>
</tr>
<tr>
<td>50.00</td>
<td>10.85</td>
<td>3.91</td>
<td>0.24</td>
</tr>
</tbody>
</table>

This is close to the spacing which emerges for Morlet wavelets with an oscillation parameter of 3.
8.4. Time sampling

Time sampling is uniform for the complex demodulation and wavelets. Generally, the re-sampled data set (after time-frequency decomposition) has a time sampling rate that is either the same or lower than the original time sampling.

In complex demodulation, the time sampling is given by a time-frequency sampling parameter that is adjusted by the user.

In wavelets, time sampling is automatically calculated such that no information is lost for the highest frequency wavelet. This will automatically ensure that also for lower frequencies, time sampling retains the time information contained in the data.

For Morlet wavelets:

\[ \sigma_t = \frac{1}{2\pi} \frac{\text{oscil}}{2\pi f} \]

This value is computed for \( f_{\text{max}} \), and again sampled at \( 0.8 \times \sigma_t \) as in the frequency sampling case. If possible, the nearest sampling rate is found (within ±10% of that value) that is rounded to full milliseconds and keeps an integer number for the number of samples.

For Mexican Hat wavelets,

\[ \sigma_t = \frac{1}{2\pi f} \]

The same procedure is followed as for Morlet wavelets.

For example, in a data set of 1600 ms:

<table>
<thead>
<tr>
<th>Method</th>
<th>High cutoff frequency</th>
<th>Number of oscillations</th>
<th>Calculated sampling interval</th>
<th>Adjusted sampling interval</th>
</tr>
</thead>
<tbody>
<tr>
<td>Morlet wavelet</td>
<td>60 Hz</td>
<td>5</td>
<td>10.610 ms</td>
<td>10 ms</td>
</tr>
<tr>
<td>Mexican Hat wavelet</td>
<td>25 Hz</td>
<td>n/a</td>
<td>5.092958 ms</td>
<td>4 ms</td>
</tr>
</tbody>
</table>

8.5. Cone of influence

When applying time-frequency decompositions to finite length time-series, the resulting transforms inevitably suffer from border distortions. This is due to the fact that the values of the transform at the start and the end of the time-series are always incorrectly computed, since they involve missing values of the series which are then artificially prescribed. To minimize these edge effects, it is recommended to **pad** the time-series of each epoch with additional data prior to the epoch start and after the epoch end. The region in which the result of a time-frequency decomposition suffers from these effects is called the cone of influence (COI). In this area the results are subject to border distortions and have to be interpreted carefully.

The figure below shows a temporal-spectral evolution plot for power based on a Wavelet transform (Morlet wavelets). The cone of influence, which indicates the region affected by edge effects, is shown with a blue dashed line.
A step-by-step guide to wavelet analysis is given by Torrence and Compo (1998). This paper also introduces the cone of influence and its mathematical description.

Notes

- If you start BESA Connectivity from BESA Research, a default padding of 2 seconds before and after each trial epoch is added. This will in most cases solve the issues of the cone of influence. The tables below show padding values for Morlet wavelet parameters, Mexican hat wavelets, and complex demodulation parameters.

<table>
<thead>
<tr>
<th>Start frequency [Hz]</th>
<th>Wavelet width</th>
<th>Wavelet oscillations</th>
<th>Padding required [s]</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.5</td>
<td>3</td>
<td>3</td>
<td>2.9</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>4.8</td>
<td></td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>8.0</td>
<td></td>
</tr>
<tr>
<td></td>
<td>7</td>
<td>11.1</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>3</td>
<td>1.4</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>2.4</td>
<td></td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>4.0</td>
<td></td>
</tr>
<tr>
<td></td>
<td>7</td>
<td>5.6</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>3</td>
<td>0.7</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>1.2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>2.0</td>
<td></td>
</tr>
<tr>
<td></td>
<td>7</td>
<td>2.8</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>3</td>
<td>3</td>
<td>0.3</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>0.5</td>
<td></td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>0.8</td>
<td></td>
</tr>
<tr>
<td></td>
<td>7</td>
<td>1.1</td>
<td></td>
</tr>
</tbody>
</table>

Morlet wavelet parameters and required padding to avoid cone of influence for different start frequencies
Time-Frequency methods

### Mexican hat wavelet:
Required padding to avoid cone of influence for different start frequencies. There are no wavelet parameters to modify wavelet shape here.

<table>
<thead>
<tr>
<th>Start frequency [Hz]</th>
<th>Padding required [s]</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.5</td>
<td>2.7</td>
</tr>
<tr>
<td>1</td>
<td>1.6</td>
</tr>
<tr>
<td>2</td>
<td>0.9</td>
</tr>
<tr>
<td>5</td>
<td>0.41</td>
</tr>
</tbody>
</table>

### Start frequency [Hz] | Time-frequency sampling [Hz, ms] | Padding required [s]
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0.5</td>
<td>0.2, 250</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>0.25, 200</td>
<td>1.6</td>
</tr>
<tr>
<td>1</td>
<td>0.2, 250</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>0.25, 200</td>
<td>1.6</td>
</tr>
<tr>
<td></td>
<td>0.5, 100</td>
<td>0.8</td>
</tr>
<tr>
<td>2</td>
<td>0.2, 250</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>0.25, 200</td>
<td>1.6</td>
</tr>
<tr>
<td></td>
<td>0.5, 100</td>
<td>0.8</td>
</tr>
<tr>
<td></td>
<td>1.0, 50</td>
<td>0.4</td>
</tr>
<tr>
<td>5</td>
<td>0.2, 250</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>0.25, 200</td>
<td>1.6</td>
</tr>
<tr>
<td></td>
<td>0.5, 100</td>
<td>0.8</td>
</tr>
<tr>
<td></td>
<td>1.0, 50</td>
<td>0.4</td>
</tr>
<tr>
<td></td>
<td>2.0, 25</td>
<td>0.2</td>
</tr>
<tr>
<td></td>
<td>2.5, 20</td>
<td>0.16</td>
</tr>
</tbody>
</table>

Complex demodulation parameter and required padding to avoid cone of influence for different start frequencies

- If you are using the TSE (temporal-spectral evolution) option, you should ensure that your baseline interval does not overlap with the cone of influence, since this may distort your TSE results over the whole time range in the affected frequency bands.
9. Connectivity methods

BESA Connectivity 1.0 offers six connectivity measures in the frequency domain. Three measures are phase-based methods: coherence, imaginary part of coherency (or imaginary coherence), and phase locking value (PLV). The other three measures are Granger causality-based connectivity approaches: Granger causality in the frequency domain (or Granger–Geweke causality), partial directed coherence (PDC), and directed transfer function (DTF). An overview of the distinctions between the connectivity measures is given in Table 1.

Table 1. Comparison of the methods for estimating brain connectivity.

<table>
<thead>
<tr>
<th></th>
<th>Coherence</th>
<th>Imaginary coherence</th>
<th>PLV</th>
<th>Granger causality</th>
<th>PDC</th>
<th>DTF</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nondirectional</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Directional</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Bivariate</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Multivariate</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>●</td>
</tr>
<tr>
<td>Linear</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Frequency domain</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
</tbody>
</table>

9.1. Coherence

Coherence is a measure of the linear relationship between two signals at a specific frequency. In practice, the magnitude of the coherency is generally used for coherence. Coherency is defined as the normalized cross-spectrum:

$$C_{xy}(f) = \frac{\langle S_{xy}(f) \rangle}{\sqrt{\langle S_{xx}(f) \rangle \langle S_{yy}(f) \rangle}},$$

where $\langle \cdot \rangle$ indicates averaging over trials, $S_{xy}$ is the cross-spectral density between two signals, and $S_{xx}$ and $S_{yy}$ are the autospectral densities for signals $x$ and $y$, respectively. Coherence is defined as the magnitude of coherency

$$\text{Coh}_{xy}(f) = |C_{xy}(f)| = \left| \frac{\langle S_{xy}(f) \rangle}{\sqrt{\langle S_{xx}(f) \rangle \langle S_{yy}(f) \rangle}} \right|.$$

The estimated coherence for a given frequency ranges between 0 and 1. A value of 0 indicating that the two signals are perfectly uncorrelated, and a value of 1 indicates perfect correlation. Coherence is a bivariate measure, which means it considers only two signals simultaneously. It is also a nondirectional connectivity measure, that is, $\text{Coh}_{xy}(f) = \text{Coh}_{yx}(f)$. 
9.2. Imaginary Part of Coherency

Instead of estimating the magnitude of the coherency, Nolte et al. (2004) proposed using only the imaginary part of the coherency to investigate brain interactions. This is because the imaginary part of the coherency excludes coherent sources with zero phase lag and therefore reduces the effect of field spread due to volume conduction.

The imaginary part of coherency is defined as

\[ IC_{xy}(f) = \text{imag} \left( c_{xy}(f) \right) = \text{imag} \left( \frac{S_{xy}(f)}{\sqrt{S_{xx}(f)S_{yy}(f)}} \right) , \]

where \( \text{imag}(\cdot) \) denotes the imaginary part.

The imaginary part of coherency for a given frequency ranges between -1 and 1. If the value is positive, signals \( x \) and \( y \) are interacting and \( y \) is earlier than \( x \), indicating that information is flowing from \( y \) to \( x \). The imaginary part of coherence is a bivariate measure as the coherence, and it is antisymmetric, that is, \( IC_{yx}(f) = -IC_{xy}(f) \).

9.3. Phase Locking Value

Phase locking value (PLV) is a measure for phase synchronization. The PLV is defined based on the average of phase angle difference between two signals over time at a specific frequency (Lachaux et al., 1999):

\[ PLV_{xy}(f) = \left| \frac{1}{n} \sum_{t=1}^{n} e^{i(\phi_x - \phi_y)} \right| , \]

where \( n \) is the number of time points, \( i \) is the imaginary number that results from taking the square root of -1, and \( \phi_x \) and \( \phi_y \) are phase angles from signals \( x \) and \( y \) at frequency \( f \).

The PLV takes values between 0 and 1. A value close to 1 means perfect phase locking, while a value close to 0 results from a random phase distribution over time. PLV is a nondirectional connectivity measure, that is, \( PLV_{xy}(f) = PLV_{yx}(f) \).

The coherence and PLV could provide similar results in many cases. However, coherence can be influenced by strong increase or decreases in power as it considered power information of the signals. For instance, if connectivity increases but the amplitudes of signals simultaneously decreases, estimated coherence values could be biased. PLV is insensitive to the amplitudes of signals and only depends on the phase relationship between two signals.

9.4. Granger causality-based connectivity measures

Connectivity measures based on Granger causality in the frequency domain can be calculated with parametric approach (with autoregressive models) or with non-parametric approach (with Fourier or wavelet-based methods) (Dhamala et al., 2008a and 2008b). These approaches differ in how the transfer function matrix computed. The transfer function matrix \( H(f) \) contains information about the relationships between signals and their spectral characteristics, and it allows for estimating causal relationships since it is nonsymmetric matrix. Once the transfer function is estimated, causality measures in frequency domain based on Granger causality can be accordingly computed.

The non-parametric approach is based on the fact that the cross-spectral density matrix \( S(f) \) can be factored into a noise covariance \( \Sigma \) and spectral transfer function \( H(f) \) by applying Wilson's spectral matrix factorization (Wilson, 1972). In comparison to the parametric estimation technique, the main advantage using the non-parametric technique is that it does not require the determination of the model order for the autoregressive model. The choice of the appropriate model order can be problematic. In contrast, the non-parametric spectral factorization approach requires more data and a smooth shape of the cross-spectral density matrix (i.e., no sharp peaks as a function of frequency) to
converge to a stable result. Moreover, the non-parametric approach utilizes data points from broad frequency range (ideally from 0 Hz to Nyquist frequency).

In the BESA Connectivity 1.0, the non-parametric approach is implemented for connectivity measures based on Granger causality.

### 9.5. Granger Causality

Granger causality states that if past values of time series $y(t)$ contains information that helps in the prediction of time series $x(t)$, then $y(t)$ is said to cause $x(t)$ (Granger 1969). The bivariate Granger causality from signal $y$ to signal $x$ can be derived out of the univariate autoregressive model of $x$ and the bivariate model of $x$ and $y$:

$$GC_{y\rightarrow x} = \ln\left(\frac{\text{Var}_{x|y}}{\text{Var}_{x}}\right),$$

where $\text{Var}_{x|y}$ is the variance of the residual in the univariate model, and $\text{Var}_{x}$ is the variance of the residual in the bivariate model. If the past values of $y$ improve the prediction of $x$, then the variance $\text{Var}_{x|y}$ is decrease. In this case, the variance ratio is larger than 1, which leads to a Granger causality value that is larger than 0.

Geweke (1982) applied the concept of the Granger causality in the frequency domain. Therefore, the Granger causality in the frequency domain is also called as Granger-Geweke causality. In the BESA Connectivity, the Granger causality in the frequency domain is implemented.

### 9.6. Partial Directed Coherence

The partial directed coherence (PDC) is a multivariate directional connectivity measure that shows the direct interrelations between signals (Baccala and Sameshima, 2001). The magnitude of PDC is defined as:

$$|\text{PDC}_{ij}(f)| = \frac{|A_{ij}(f)|}{\sqrt{\sum_{k=1}^{N} |A_{kj}(f)|^2}},$$

where $A_{ij}(f)$ is an element of the $\Lambda(f) = H^{-1}(f)$ (the inverse matrix of the transfer function). The PDC$_{ij}(f)$ describes the directional flow of information from the activity in $j$-th signal to the $i$-th signal ($j \rightarrow i$). The PDC quantity is normalized between 0 and 1, producing a ratio between transmission from signal $j$ to signal $i$ and total outflow from signal $j$ (the sum along the columns of $\Lambda(f)$).

### 9.7. Directed Transfer Function

The directed transfer function (DTF) is a multivariate directional connectivity measure that displays the direct and indirect interactions between signals (Kaminski and Blinowska, 1991). The magnitude of DTF is defined as:

$$|\text{DTF}_{ij}(f)| = \frac{|H_{ij}(f)|}{\sqrt{\sum_{k=1}^{N} |H_{ik}(f)|^2}},$$

where $H_{ij}(f)$ is an element of the transfer function matrix $H(f)$. The DTF$_{ij}(f)$ expresses the directional flow of information from the activity in $j$-th signal to the $i$-th signal ($j \rightarrow i$). The DTF quantity is normalized between 0 and 1, producing a ratio between the influence of signal $j$ on signal $i$ and the summarized inflow to signal $i$ (the sum along the rows of $H(f)$).
10. The Workflow Concept

BESA Connectivity uses a modern workflow concept that guides you through all the work steps needed to complete a project, suggests and explains necessary inputs and user actions, and performs many work steps automatically. At any time, you may interrupt and inspect earlier work steps or redo them with modified input parameters if required.

A workflow consists of a series of work steps required to finalize a project. Each work step contains a set of user interactions needed to achieve the work step-specific result. Only few user interactions are needed.

When pressing the Next button or Space, a work step is completed and the next work step is loaded. Thus, the workflow of a project sequentially proceeds from one work step to the next.

The layout of the BESA Connectivity screen is optimized for this workflow concept. The workflow menu—as shown on the left in the Workflow Window—gives an overview over all the work steps to be completed in the selected project (see 10). The workflow menu can be used to switch between the work steps. For example, you may redo an earlier step with different or advanced parameters and continue with automatic processing of all subsequent steps as defined before.

The current results during a work step are shown in the Main Window in the center of the screen (see 11.2). The Information Window below (see 11.3) provides advice and help information for the current work step.

During each work step a specific dialog is shown in the Interaction Window on the right to allow for optimized user interaction relevant for the current work step (see 11.4). After completing all interactions, press the Next button at the bottom or Space to proceed to the next work step. Press the Previous button to go back one work step. After completing the last work step of the workflow, press the Finish button at the bottom of the Interaction Window to save all data created during the project. This saving step enables reloading the full workflow of a project with all work steps at a later time.

A project is defined by a specific workflow together with the stored individual input and output data. Stored projects can be viewed by selecting the menu item File → Open Project, by using the Open button in the toolbar, or by pressing the Open Project buttons on the start screen. After opening a stored completed project, the final workflow result is displayed.
11. **Elements of the BESA Connectivity Screen**

The layout of BESA Connectivity screen is optimized for the workflow concept as described in chapter 10. The figure below shows the BESA Connectivity screen with all its elements:

1. **Workflow Window** (see chapter 10)
2. **Main Window** (see chapter 11.2)
3. **Information Window** (see chapter 11.3)
4. **Interaction Window** (see chapter 11.4)
5. **Title Bar** (see chapter 12.1)
6. **Menu Bar** (see chapter 12.2)
7. **Caption** (see chapter 12.3)
8. **Toolbar** (see chapter 12.4)
11.1. Workflow Window

The Workflow Window on the left displays the workflow menu. The workflow menu gives an overview over the sequential steps needed to finish the current project. Steps already completed are marked with a green check mark.

The current work step is highlighted. This step is also shown in the caption.

The workflow menu can be used like any other menu to jump to another work step provided that the previous work steps have already been completed.

11.2. Main Window

The Main Window area displays the results of the current work step.

11.3. Information Window

The information window displays a comprehensive help text related to the current work step. The help texts provide additional information, e.g. which file has been loaded. They suggest and explain the next user interaction to be done in the current work step.

Underlined text in blue provides a hyperlink. Click on such a link to open the BESA Connectivity help at the indicated topic.

11.4. Interaction Window

The Interaction Window provides the user interaction for the current work step.

The upper interaction elements are used to set parameters needed in the work step by using standard elements like buttons, edit boxes, and sliders. The effect of changing parameters is seen in the Main Window left of the Interaction Window.

In some work steps, additional interaction elements are shown at the bottom of the Interaction Window to enable changing visualization parameters.

Current parameters are accepted by pressing Space, or by pressing the Next button at the bottom prompting the workflow to proceed to the next work step.

The Previous button is used to jump back to the previous work step.

11.4.1. Notes

1. You can also undo or redo a work step using the menu items Edit \rightarrow Undo and Edit \rightarrow Redo or by pressing Ctrl-Z or Ctrl-Y.

2. Moving on to the next work step is fastest by pressing Space or Enter.
12. Program Bars

12.1. Title Bar

The title bar of BESA Connectivity displays the program name and version number. In addition, it shows information on the current project:

- Group name
- Project name
- Project type

12.2. Menu Bar

The Menu Bar provides the menus listed below. Click on a menu to select and choose from the menu items that pop up.

12.2.1. File Menu

The File menu contains the following items:

<table>
<thead>
<tr>
<th>File menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create New Project</td>
<td>Start a new project.</td>
</tr>
<tr>
<td>Open Project</td>
<td>Load an existing project. A choice can be made between project types time-frequency and connectivity.</td>
</tr>
<tr>
<td>Close Project</td>
<td>Close currently active project. Show the Select Project Page.</td>
</tr>
<tr>
<td>Save</td>
<td>Save the currently active project.</td>
</tr>
<tr>
<td>Save As…</td>
<td>Specify a filename for currently active project and save it.</td>
</tr>
<tr>
<td>Delete Projects…</td>
<td>Select one or multiple projects that shall be.</td>
</tr>
<tr>
<td>Select Data Folder</td>
<td>Select the folder to be used as BESA Connectivity Data Folder (see 6.3.3).</td>
</tr>
<tr>
<td>Update Data Folder Info</td>
<td>Update the information file in the BESA Connectivity Data Folder (see 6.3.3).</td>
</tr>
<tr>
<td>Exit</td>
<td>Terminate the BESA Connectivity program.</td>
</tr>
</tbody>
</table>

12.2.2. Edit Menu

The Edit menu contains the following items:

<table>
<thead>
<tr>
<th>Edit menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>Undo the last step completed in the current work step.</td>
</tr>
<tr>
<td>Redo</td>
<td>Redo the last step that was undone in the current work step.</td>
</tr>
</tbody>
</table>
12.2.3. View Menu

The View menu can be used to change display settings for BESA Connectivity. It contains the following entries:

<table>
<thead>
<tr>
<th>View menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Workflow Window</td>
<td>By selecting or deselecting this menu item the Workflow Menu is displayed or hidden (see 10).</td>
</tr>
<tr>
<td>Show Information Window</td>
<td>By selecting or deselecting this menu item the Information Window is displayed or hidden (see 11.3).</td>
</tr>
<tr>
<td>Standard Font Size,</td>
<td>Select one of these menu items to specify the size of the font to be used in BESA Connectivity.</td>
</tr>
<tr>
<td>Large Font Size,</td>
<td></td>
</tr>
<tr>
<td>Extra Large Font Size</td>
<td></td>
</tr>
<tr>
<td>Settings</td>
<td>Allows adjusting the color map used in 2D time-frequency and connectivity displays – separately for the case of sequential data and diverging data.</td>
</tr>
</tbody>
</table>

12.2.4. Export Menu

The Export menu can be used for exporting vector graphics (*.eps), scalable vector graphics (*.svg) or bitmap images (*.png) of the Main Window, of the detail windows, or of a combination of all windows. For 3D visualization in the Connectivity workflow (see 15.4.1), the connectivity changes over time can be exported as video (*.mpg).

Results can be exported in ASCII format for further processing in external programs if needed. For time-frequency analysis it is possible to export single trial data, averaged data, and averaged waveforms. Connectivity data can be also exported.

<table>
<thead>
<tr>
<th>Export menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image</td>
<td>Allows exporting images of the Main Window, the left detail window, the right details window, or all windows. In the Save dialog, the format (*.eps, *.png, or *.svg) can be specified. Images can also be exported by right-clicking in the according window.</td>
</tr>
<tr>
<td>Video</td>
<td>For 3D visualization in the Connectivity workflow this item allows exporting video animations of the Main Window, the left detail window, the right details window, or all windows. In the Save dialog, the resolution, start time, end time, and duration per latency step can be specified. The rotation can be applied in degrees. Rotation can be uni-directional or bidirectional. Also, the background color can be changed. After pressing the recording button, video generation starts. When it is finished it can be previewed and saved as *.mpg file.</td>
</tr>
<tr>
<td>Export Results</td>
<td>Functionality of this menu entry is workflow-dependent. For the Time-frequency workflow it is possible to export ASCII data for single trials TF (<em>.tfc), averaged TF (</em>.tfc), and averaged waveforms (<em>.avr). In the Connectivity workflow, connectivity data can be exported as well (</em>.conn). All these files are ASCII files with appropriate header line.</td>
</tr>
</tbody>
</table>
12.2.5. Help Menu

Use the Help menu to open the program help or to get information about BESA Connectivity.

<table>
<thead>
<tr>
<th>Help menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>BESA Connectivity Help</strong></td>
<td>Open the program help.</td>
</tr>
<tr>
<td><strong>About…</strong></td>
<td>Get information about the current program version.</td>
</tr>
</tbody>
</table>

12.3. Caption

The caption is located between the Menu Bar and the Toolbar and specifies the current work step.

12.4. Toolbar

The Toolbar provides direct access to the most important menu items:

- File ➜ Create New Project
- File ➜ Open Project
- File ➜ Close Project
- File ➜ Save Project
- Edit ➜ Undo
- Edit ➜ Redo
13. **How to use BESA Connectivity**

Before working with BESA Connectivity, please consult chapter 11 on the elements of the BESA Connectivity screen.

13.1. **Starting BESA Connectivity**

13.1.1. **Welcome Screen**

Start BESA Connectivity from its icon on the desktop.

When starting BESA Connectivity, a welcome screen appears. It provides some information on the BESA Connectivity program including the current version number and date:

![BESA Connectivity Welcome Screen](image)

Press **Accept** to start BESA Connectivity.
13.2. The Workflows of BESA Connectivity

Two different workflows can be chosen: **Time-Frequency Analysis** and **Connectivity Analysis**. Each workflow consists of specifying the analysis method, loading EEG/MEG data (for the Connectivity workflow a Time-Frequency analysis project outcome has to be used), specifying parameters, and calculation. The work steps are described in detail in the following chapters.

13.3. Select workflow – Analysis type

In order to start a workflow, a selection of the analysis type must be made:

- **Time-Frequency Analysis**
- **Connectivity Analysis**
- **Open Project**

Press **Start** to initialize the selected workflow. For a more detailed description of the analysis methods, please see the previous chapters 8 and 9.

13.3.1. Notes

Projects can also be started or opened at any time by selecting the menu items File → Create New Project or File → Open Project.

14. **Workflow: Time-Frequency Analysis**

14.1. **Set Project targets**

The time-frequency analysis method needs to be specified from multiple selection options:
• **Complex Demodulation**: Data will be transformed to time-frequency domain using complex demodulation (see chapter 8.1 for more details)

• **Wavelet Transform**: Data will be transformed to time-frequency domain using one of two possible wavelet approaches (see chapter 8.2 for more details)
  - Wavelet Morlet
  - Wavelet Mexican Hat

• **Number of Conditions**: Up to two conditions (e.g. target and control) can be provided

• **Condition 1**: A name for the first condition

• **Condition 2**: If number of conditions is equal to two, a name can be provided for the second condition

The number of conditions and condition names will be automatically detected if the workflow is started from the BESA Research software.

After selecting the analysis method data has to be loaded and some further settings need to be specified. Press **Next** to go to the next work step.

**14.2. Load data**

In this work step data for the analysis have to be provided. The number of datasets to load depends on the number of conditions declared in the previous step. BESA Connectivity reads the *.generic* file format which is the output from BESA Research. The generic files can be easily generated from any other software following the format description. Please see chapter 18.3 for further details.

Pressing the first **Load Data for <Condition 1>** button will bring up a file selector box (Condition 1 text will be replaced with the actual name of the first condition). If two conditions were indicated in the **Set Project Targets** work step, a second button **Load Data for <Condition 2>** will be available. Pressing this button will also bring up a file selector box.
After file opening, the details of each loaded file will be displayed.

Press **Next** to go to the next work step or **Previous** to switch back to the **Set Project Targets** work step.

### 14.3. Set Parameters

The window layout for the **Set Parameters** work step in the Time-Frequency workflow is presented below.

The Main Window shows single trial waveforms, as selected in the interaction window, for the indicated condition and every channel / source.

The left Detail Window displays an averaged waveform from all selected trials, for the selected channel.

The right Detail Window displays the selected single trial waveform for the indicated condition and channel / source.
The Time-Frequency settings consist of three parameters.

The Select trials window allows to review the single trials before performing time-frequency computation. Individual trials can be excluded if needed. To exclude trial from further analysis a green checkbox adjacent to the trial number has to be unchecked.

After selecting any of the trials, you can browse through the individual trials quickly by using the cursor up and cursor down keys on the keyboard.

The Low Frequency Cutoff can be adjusted. By default, the low frequency cutoff is set to the minimum value possible for the provided data and method. The lowest frequency possible depends on the method settings of Complex Demodulation and/or Wavelet.

The High Frequency Cutoff is detected from the data sampling and set to the highest possible value (that is below the Nyquist frequency). This value can be adjusted by selecting the value from the dropdown list.

The Wavelet settings depend on the wavelet type selected in the Set Project Targets workstep. The wavelet type is indicated in the widget. For Morlet wavelets, the following settings can be adjusted:

Wavelet Width determines the width of the envelope function (Gaussian kernel) used for creation of the wavelet. Shorter wavelets will provide a finer temporal resolution at the expense of a coarser frequency resolution and vice versa.

Number of Oscillations determines the number of oscillations present in the wavelet. Wavelets with lower number of oscillations will provide a finer temporal resolution at the expense of a coarser frequency resolution and vice versa.

Larger wavelet widths or larger number of oscillations require longer wavelets, which in turn requires more padding at each side of the data for calculation. If not enough padding is available, zero padding is added. Please note that this can influence the data (cf. chapter 8.5 for more information).
Display Left enables or disables the presentation of average signal from all trials used for further analysis (defined in Select Trials widget) in the left Detail Window. Display Top/Left/Right allows to switch between Condition 1 and Condition 2 display in the Main Window, the left and the right Detail Window. In main and right windows, the currently selected waveform of a single trial is presented, whereas in the left detail window an average waveform of the selected channel for the selected condition is shown.

Select Channel / Source: Depending on the loaded data file montage (source montage or channel montage) an appropriate text is displayed. This dropdown selection box allows the selection of a desired channel / source to be displayed in the Detail Windows. Alternatively, the channel / source of choice can be selected in the Main Window by a left-click. The arrow buttons left and right of the channel selector box can be used to quickly browse through all channels / sources.

Current Latency allows setting a cursor at a particular latency (the slider can be dragged to the point of interest or the arrow buttons at the left and right of the slider bar can be used to adjust the position).

Scale allows altering the scaling of the data. The arrow buttons at the left and right of the slider bar can be used to scale the data up or down.

Zoom allows viewing the Main Window contents in greater detail. The arrow buttons at the left and right of the slider bar can be used to adjust the zoom factor. For zooming the mouse wheel can be used as well. The black frame at the left of the Zoom slider displays the position of the currently displayed window fraction relative to the complete window. The frame can be left-dragged to another relative position. Alternatively, it is possible to left-drag the Main Window while holding down the control key.

14.4. Perform Calculations

Pressing Run Time-Frequency Analysis opens a window with a summary of the Time-Frequency Analysis Settings. If Wavelet computation was selected the name of the selected wavelet is indicated and, if applicable, its width and number of oscillations. If Complex Demodulation was selected the time-frequency sampling values are shown. If these values need changing, it is possible to return to the Set Parameters work step by pressing Cancel and the Previous button. Confirming the summary window with OK will start the time-frequency analysis. Please note that depending on the number of channels/sources and data points, the computation might take several minutes.

After performing the computation, the results are displayed:
The Main Window shows the time-frequency plot for each channel / source for the selected time-frequency analysis method, display type, and condition.

The left Detail Window displays an averaged waveform from all selected trials, for the selected channel.

The right Detail Window displays a time-frequency plot for the chosen channel / source with the selected time-frequency analysis method, display type, and condition.

Note that the color map for showing the data can be changed in the View menu: For TSE display, the currently selected diverging color map is used; for ABS display, the currently selected sequential color map is used.

When hovering over the left or right detail window, the value of waveform amplitude or time-frequency decomposed data for the given time-frequency sample is displayed in a tooltip text.

Using the Blue-to-Red diverging color map in TSE display
If more than one Time-Frequency analysis method was used, it is possible to switch between them by selecting one of the methods from the Select Time-Frequency Method dropdown list.

In the Select Display Type selection group, the display can be switched between temporal-spectral evolution (TSE) or Absolute (ABS) value, for Amplitude or Power.

The averaged waveform display of the Detail Window can be switched on or off in the Display Left checkbox. By changing the selection in Display Top/Right the condition for which data are displayed can be changed (if more than one condition was selected in the beginning of the workflow).

Select Channel / Source: Depending on the loaded data file montage (source montage or channel montage) an appropriate text is displayed. This dropdown list allows the selection of a desired channel / source to be displayed in the Detail Windows. Alternatively, the channel / source of choice can be selected in the Main Window by a left-click. The arrow buttons left and right of the channel selector box can be used to quickly browse through all channels / sources.

The crosshair position over the time-frequency plot can be selected either by left mouse click on the desired position in the right Detail Window, by a double click in the Top View display, or by adjusting the Current Latency [ms] and Current Frequency [Hz] settings sliders.

The remaining settings in the Interaction Window are analogous to the Set Parameters (see 14.3).

Pressing Finish saves the current project.

After specifying a group and project name, projects including all completed workflows steps will be saved and marked with a green check mark. Completed, but not finished projects are marked by a green dot. Incomplete projects are marked by a red dot.

A project can be re-opened at any time by pressing File / Open Project.
Workflow: Connectivity Analysis

15. Set Project targets

There are multiple selection options for specifying the connectivity analysis method:

- **Coherence**: describes the amount of in-phase components of two signals at a specific frequency (Rosenberg et al., 1989).
- **Imaginary Part of Coherence**: excludes coherent sources with zero phase lag and therefore reduces the effect of field spread due to volume conduction (Nolte et al., 2004).
- **Phase Locking Value**: is the average of phase angle difference between both signals over time at a specific frequency (Lachaux et al., 1999).
- **Granger Causality**: states that if past values of time series $y(t)$ contains information that helps in the prediction of time series $x(t)$, then $y(t)$ is said to cause $x(t)$ (Granger, 1969; Geweke, 1982).
- **Partial Directed Coherence**: measure that only shows the direct interrelations between the signals (Baccala and Sameshima, 2001).
- **Directed Transfer Function**: was introduced to reveal indirect information transfer between signals (Kaminski and Blinowska, 1991).

For more details about each connectivity analysis method please refer to chapter 9 or to the original research papers mentioned for each method.

15.2. Load data

Since connectivity computation is based on time-frequency data, this workflow requires data from a time-frequency analysis project.

Pressing the **Select Time-Frequency Input Project** button will bring up a project selector box with project type filter fixed to Time-Frequency Projects. Choose the desired project from any group and press **Open** to proceed.

If an unfinalized project is selected (indicated by a red dot) a prompt dialog will be shown. Press **Yes** if workflow type should be switched back to time-frequency analysis in order to finalize the project. Press **No** or **Cancel** to select another project.

After loading the project, the related details will be displayed in the Main Window, similarly to the **Load data** work step of the Time-Frequency analysis workflow (14.2)
Press **Next** to go to the next work step or **Previous** to switch back to the **Set Project targets** work step.
15.3. Set Parameters

The window layout for the Set Parameters work step in the Connectivity workflow reflects the calculations performed in time-frequency analysis and is presented below.

The Main Window shows the time-frequency plot for each channel / source for the selected time-frequency analysis method, display type, and condition.

The left Detail Window displays an averaged waveform from all selected trials, for the selected channel.

The right Detail Window displays a time-frequency plot for the selected channel / source with the selected time-frequency analysis method, display type, and condition.

If any of the non-parametric connectivity methods were selected in the Set Project Targets work step (Granger Causality, Partial Directed Coherence, or Directed Transfer Function), the additional Non-Parametric Methods Settings widget is available.

The Number of Iterations, Tolerance, and Regularization can be adjusted either by editing the values manually or by clicking the left arrow to decrease / right arrow to increase.

These parameters are required during the factorization of the cross-spectral density matrix. In each iteration, the estimation error of the spectral factors is recomputed. If the estimation error is lower than the tolerance threshold, the computation of this iteration is finished. The regularization (%) is applied in order to ensure a smooth shape of the cross-spectral density matrix. The regularization of 0.01 indicates that a regularization parameter is set to 1% of mean of power spectral density values.

The remaining settings in the Interaction Window are analogous to the Perform Calculation work step of the Time-Frequency Analysis workflow (chapter 14.4).
15.4. Perform Calculations

Pressing Run Connectivity Analysis opens a window with a summary of the Connectivity Analysis Settings. All selected methods are listed. If non-parametric methods are planned to be computed (Granger Causality, Partial Directed Coherence, or Directed Transfer Function) the related settings are also displayed. If any of the values need to be changed, it is possible to return to the Set Parameters work step by pressing Cancel and the Previous button. Confirming the summary window with OK will start the time-frequency analysis. Please note that depending on the selected connectivity method, the number of iterations in non-parametric settings, number of channels/sources and data points, the computation might take several minutes.

After finalizing the computation the results are displayed:

In the Main Window, results are displayed either in a grid view to show all connectivity patterns in one view, or in a 3D view (15.4.1), which shows either connectivity with connection strength encoded by thickness of connecting arrows, or the sum of inflow/outflow. The left Detail Window displays backward connectivity between channels / sources indicated by row and column in Top Window (Left and Right Source in selection widget). The right Detail Window displays forward connectivity between channels / sources indicated by row and column in Top Window (Left and Right Source in selection widget).

Note that the color map for showing the data can be changed in the View menu: For Imaginary part of Coherency display, the currently selected diverging color map is used; for display of any other connectivity method, the currently selected sequential color map is used. When hovering over the left or right detail window, the value of connectivity for the given time-frequency sample is displayed in a tooltip text.
Select Connectivity Method dropdown menu and Select Time-Frequency Method can be used to change the displayed results in the Main Window.

Checking Show 3D Mode checkbox enables 3D mode. This mode is described in more detail in chapter 15.4.1.

If the analysis was performed for more than one condition, the displayed condition can be changed by selection in the Display Top/Left/Right section. Additionally, the matrix diagonal (Normalized Power Spectral Density – Normalized PSD) can be hidden by checking the Hide Diagonal checkbox.

The displayed connectivity between selected channels in left and right Detail Windows can be changed either by clicking on one of the plots available in the matrix in the Main Window, or by indicating the desired channels/sources in the Select Left Target Channel/Source and Select Right Target Channel/Source dropdown menus. These menus can also be scrolled by the arrows adjacent to both menus.

The crosshair horizontal position can be adjusted by changing the position of the Current Latency [ms] slider. The crosshair vertical position can be altered by changing the position of the Current Frequency [Hz] slider. If the crosshair position is manually changed by clicking the left mouse button on the desired position in either the Left or Right Detail Window, the values of the Current Latency slider and Current Frequency slider will be automatically updated. Finally, the crosshair position is also updated by a double click into the selected channel in the top part of the Main Window display.

If the Average over Time checkbox is enabled additional controls are shown and plots are averaged over time. The Start Time [ms] slider and End Time [ms] sliders indicate the time window that will be averaged over. The display changes: the X axis shows frequency and the Y axis shows connectivity values for the selected method (e.g. Coherence).

The averaging can be performed also in the frequency domain by enabling Average over Frequency. Now, the averaging window can be adjusted by the displayed Start Frequency [Hz] slider and End Frequency [Hz] slider. Plots show time values on the X axis; the Y axis shows connectivity values for the selected method (e.g. Coherence).
The remaining settings in the Interaction Window are analogous to the Set Parameters work step (14.3)

15.4.1. 3D Mode

If the **Show 3D Mode** checkbox is enabled in the Interaction Window, the Main Window will display an averaged transparent brain surface (in case that brain sources are analyzed) or a non-transparent scalp surface (for sensor data analysis). The brain surface was kindly supplied by John E. Richards, University of South Carolina, USA (Richards et al., 2016). This view shows the brain connectivity for the selected time and frequency, also if averaging over time or frequency is applied. The controls available in the Interaction window are adjusted for the purpose of 3D mode settings.

Hover with the mouse pointer over any of the channels to view the channel label in a tool tip. The current connectivity values of the detail window channels are displayed at the bottom left part of the central window.

In 3D view mode the **Zoom** and the **Scale** settings in **Display Settings** are not available. These settings are replaced by the 3D view specific ones.

One of three **Display** modes can be selected: Connectivity Strength, Sum Inflow and Sum Outflow. If **Connectivity Strength** is checked, cones will be displayed that indicate direction of information flow between two channels/sources: The thicker the base of the cone, the stronger the connection from the source to the destination. The reverse direction is also shown in the same way, except for Imaginary Part of Coherency where only the positive values are used.

If **Sum Inflow** is selected, all input information flow for each node (channel/source) is summarized and expressed by the node size.
Similarly, if **Sum Outflow** is selected, all output information flow for each node is summarized and expressed by the node size.

The **Threshold** slider is available only for Connectivity Strength visualization. Adjust this value either by manual editing, by moving the slider, or by pressing the left or right arrow to reject (hide) connectivity arrows with values below the selected value.

The **Scale 3D** slider allows changing the size of all connectivity arrows or inflow/outflow nodes.

To change brain visibility, adjust the **Transparency** slider value. The higher the value, the more transparent the brain will look.

In Scalp visualization, the Sum Inflow, Sum Outflow, and Transparency options are not available.

In both brain and scalp visualization modes, zooming is done interactively.

The 3D image can be rotated by left-dragging the mouse. The displayed brain or head can be moved / zoomed by left-dragging the mouse while holding down the **Ctrl / Ctrl+Shift** key.

The mouse cursor symbol signals the available interaction associated with clicking and/or dragging:

- **Rotate 3D image.**
- **Move 3D image.**
- **Zoom 3D image.**
17. Exporting Images, Video, and Results

17.1. Exporting Images

For the Set Parameters work step and after completing computation in the Perform Calculations work step for all workflows, it is possible to export resulting images in the Main Window and the Detail Windows. This can be achieved via the menu bar (see 12.2.4) or via right-clicking in the corresponding window.

Images can be saved as **portable network graphics** (*.png), **vector graphics** (*.eps) or **scalable vector graphics** (*.svg).

The selection can be made in the saving dialog under **Save as type**:

When saving *.png files, the dimension and resolution of the resulting image can be defined. By default, the current size of the image on the screen is used. Width and height can be altered with or without constraining proportions using mm or inch as units. The resolution can be set to 150, 300 or 600 dots per inch.

When saving *.eps or *.svg file, the image size cannot be changed as vector graphics are by definition fully resizable.
17.3. Exporting Video

Video export can be used to record a temporal evolution of brain connectivity for the selected frequency (or frequency range if Average over Frequency is active) in 3D view mode in the Connectivity analysis work step.

After selecting the Video export option, a settings dialog will be shown. The video can be saved with standard cinematic resolution ranging from SD (720x480 px) to UHD (3840x2160 px). The desired value can be selected from the Resolution dropdown menu.

A start and end time can be set using Start Time [ms] and End Time [ms] sliders. These values can be adjusted by manual editing, by setting the slider position or by pressing left and right arrows to increase or decrease the selected value, respectively.

The setting Duration Per Latency Step [s] can be used to decide how long one latency position will be shown in the video. This directly influences the video length which depends also on the temporal resolution, and on starting and ending time (number of temporal samples). The final video length is automatically computed and returned in the Video Length [s] field.

The Rotation [deg] value can be adjusted to decide if the 3D rendered object (brain surface or scalp) should be rotated during the video. To disable rotation, use 0 degree as rotation value. A default value of 360 degree generates a full turnaround. A checkbox marked by symbol sets the rotation to go forth and back, which may be useful if the video should loop around.

The background color of the video can be easily changed by clicking one of three rectangles with predefined colors (white, BESA sandy, or black). In addition, any color can be chosen by clicking of the button with three dots . After pressing this button an advanced color picker menu will be shown.

To start video recording press the button. The video generation can be observed in the Main Window1. After video registration is finished, the results can be previewed in the preview sub-window. To change the latency

---

1 Due to the OpenGL limitation a flickering may be visible when video is recorded. Please move the mouse cursor outside the main window to remove this effect.
shown in the preview sub-window, use a slider in the Recording section.

After finishing preparation of the video it can be saved by pressing the Save button or discarded by pressing the Cancel button. If the Save button was pressed a file save dialog will be shown. The video can be saved as ".mpg" file.

17.4. Exporting Time-Frequency Analysis Results

After the Time-Frequency analysis is completed in the Perform Calculations work step, it is possible to export analysis results via the menu bar (see 12.2.4) A choice can be made between “Export Single Trial TF Data”, “Export Averaged TF Data” and “Export Averaged Waveforms”. The result files are stored as comma-separated ASCII files. If more than one condition was used during analysis, the exported condition will be the one currently selected in the Interaction Window (14.4).

Export Single Trial TF Data will output the Time-Frequency analysis result for each trial which was selected in the Set Parameters work step (see 14.3) to a *.tfcs file. See chapter 18.2 for more details on the file format.

Export Averaged TF Data will output averaged data amplitudes of time-frequency analysis. The exported will be exactly the same data as the one used to create the Main Window display data. Data will be exported to the a *.tfc file – see 18.1 for details.

Export Averaged Waveforms will output time-domain averaged data across all trials. Before exporting the averaged waveforms for individual channels, the waveforms can be reviewed in the left Detail Window of the Main Window. Data is exported in *.avr format (see 18.6).
17.5. Exporting Connectivity analysis results

After the Connectivity analysis is completed in the Perform Calculations work step it is possible to export analysis result via the menu bar (see 12.2.4). If connectivity analysis was performed for more than one condition, the condition currently selected in the Interaction window is exported (see 15.4).

Export Connectivity Data will output channel to channel (or source to source) connectivity matrices as shown in the Main Window. The data for the currently selected connectivity analysis method and the currently selected time-frequency analysis method is exported (selection in the Interaction window, see 15.4). Data is exported as ASCII file of type *.conn. Check chapter 18.8 for more details.
18. File Formats

All BESA Connectivity output data formats are in ASCII format to facilitate human readability. All floating-point numbers are represented in scientific notation with up to eight significant digits. All complex numbers are represented in scientific notation as well, following the scheme: \( a + ib \), where \( a \) and \( b \) are real number and \( i \) is a solution of the equation \( x^2 = -1 \).

BESA Connectivity uses the BESA generic file format v1.1 (see chapter 18.3 for more details) which can be directly exported to BESA Connectivity from BESA Research version 7.0 and higher. The generic file can easily be created manually if any other MEG/EEG analysis software is intended to be used with BESA Connectivity.

18.1. The BESA Time-Frequency File Format (*.tfc)

The header line contains the following data descriptors (14 descriptors displayed in **bold**, the values shown are only examples and comments are in *italic*):

1. **VersionNumber**=_v_5.1: Version number of the current tfc file format.
2. **DataType**= TIME_FREQUENCY_AMP: Data type contained in the file. Currently, only one type is exported, independent of user settings in the program:
   - TIME_FREQUENCY_AMP: time frequency amplitude.
3. **ConditionName**=s: Condition name. Usually indicated by experiment. E.g. "high-" or " low intensity".
4. **NumberTrials**=250: Number of trials.
5. **NumberTimeSamples**=25: Number of time samples.
6. **TimeStartInMS**=100.0: Start time in [ms].
7. **IntervalInMS**=25.0: Interval length in [ms].
8. **NumberFrequencies**=24: Number of frequency bins.
9. **FreqStartInHz**=4.0: Starting frequency in [Hz].
10. **FreqIntervalInHz**=2.0: Frequency interval in [Hz] (only relevant for complex demodulation).
11. **NumberChannels**=127: Number of channels in the data set.
13. **EvokedSignalSubtraction**=Off: Flag to signal evoked signal subtraction (On if evoked signal is subtracted, Off otherwise). Currently always Off.
14. **Frequencies**=4.00;4.47;4.98;...: The frequencies used (only used for wavelets).

The second row of the header contains the labels of the channels. Their labeling can be chosen freely provided only letters and number are used and the amount of characters per entry does not exceed eight (e.g. E1 E2 ... for electrodes).

The remaining lines contain **NumberChannels** blocks starting from the first channel. Each block is separated from the next one by an empty line. Each block contains **NumberFrequencies** rows and **NumberTimeSamples** columns. The values for each time-frequency entry in the blocks are floating point numbers and should be separated by a tab.
18.2. The BESA Single Trial Time-Frequency File Format (*tfcs)

The file is created without a header.

The start of each trial export is indicated by the text “Trial” followed by the trial number. The Trial statement also separates trials in the exported file. Every time-frequency matrix (block) is preceded by the channel number, and the Channel statement separates blocks. The time-frequency data points are reported as complex numbers. Each block is organized in a table where columns represent time points (increasing from left to right) and rows represent frequencies (increasing from bottom to top). Columns are separated by tabulators.

18.3. The BESA Generic File Format v1.1 (*.generic)

The BESA generic dataset consists of:

- The header file (*.generic)
- The electrode/source definition file (*.elp for electrodes – see 18.4 or *.bsa for sources – see 18.5)
- Data file (*.dat – see 18.6)

The first line must consist of the text: “BESA Generic Data v1.1” (without the inverted commas). Previous versions are not supported.

Subsequent lines must contain the following parameters, in any order (note that the parameters are case insensitive). They contain the following data descriptors (descriptors displayed in bold, the values shown are only examples and comments are in italic):

- **nChannels = 11** The number of channels
- **sRate = 125.000** The sampling rate (samples/sec)
- **nSamples = 141918** The total number of time samples in the data.
- **format = float** Currently only float is supported.
- **file = binarydata.dat** The data file name, without path information. See 18.6 for more information
- **prestimulus = 400.000** Prestimulus interval in milliseconds
- **epochs = 218** This specifies the number of equally sized epochs in the data.
- **baselineStart = -350.000** Start of baseline relative to the trigger onset for each epoch in original dataset. The value should be given in milliseconds.
- **baselineEnd = 0.000** End of baseline relative to the trigger onset for each epoch in the original dataset. The value should be given in milliseconds.
- **epochLength = 1200.000** Length of epoch. Each epoch is indicated by the trigger position in the original dataset. The value should be given in milliseconds.
- **Padding = 2000.000** Information concerning extra data values that surround the epoch to provide padding for wavelets, expressed in milliseconds. If exported from BESA Research, the default value is 2000 ms.
- **ConditionName = name** Name of condition
**channelUnits**: Cz µV

A pair consisting of Channel/Source name and unit that was used for this Channel/Source (Volts for channels, Amperemeters for sources, with appropriate scaling indicator: e.g. µV). The pair is separated by a space. The number of channelUnits entries has to be equal to nChannels.

### 18.4. The BESA Channel Definition File Format (*.elp)

Each line of the channel definition file contains a label, an identifier, and 2D coordinates in angles. The format is: **Identifier Label Theta-coordinate Phi-coordinate**.

Identifiers can be:

- **EEG** - scalp electrode (use also instead of SCP).
- **POL** - polygraphic channel (use also instead of PGR).
- **ICR** - intracranial electrode.
- **MEG** - MEG sensor.
- **REF** - reference electrode. This can only occur once.

Labels should have at most 8 characters and be constituted only by letters and numbers, but can otherwise be chosen freely. Note though that the corresponding *.generic files (see 18.3) have to use the same convention for the label naming.

Coordinates are represented as floating point numbers in [deg] in the Head coordinate system. This coordinate system is defined by reference points on the head known as fiducials. The reference points are normally the nasion (NAS), the left preauricular point (LPA), and the right preauricular point (RPA). The x axis is defined by the line joining LPA and RPA, positive towards RPA. The y axis is defined by the line through NAS that is perpendicular to the x axis (positive towards NAS). The z axis is perpendicular to the x and y axes and goes up out of the upper part of the head (e.g. Cz). On average, the center of the unit sphere is about 4 cm above the origin of the Head coordinate system.

### 18.5. The BESA Solution File Format (*.bsa)

The file contains the position and orientation of dipoles/sources.

The first line of the file contains a dummy identifier **BSA_1.04.19990715**.

The second line of the file contains the labels: **Type, x-loc, y-loc, z-loc** (the position of the dipole/source in unit sphere Cartesian coordinates), **x-ori, y-ori, z-ori** (the unit vector orientation of the dipole/source).

This coordinate system is defined by a sphere with unit dimensions, which is fitted to the coordinates of sensors on the head. In the absence of co-registration information with individual MRI data, the axes are defined by reference points on the head known as fiducials. The reference points are normally the nasion (NAS), the left preauricular point (LPA), and the right preauricular point (RPA). The direction of the x axis is defined by the line joining LPA and RPA, positive towards RPA. The direction of the y axis is defined by the line through NAS that is perpendicular to the x axis (positive towards NAS). The z axis is perpendicular to the x and y axes, and goes up out of the upper part of the head (e.g. Cz). On average, the center of the unit sphere is about 4 cm above the origin of the Head coordinate system.
Type can assume the values:

- **SngDip** - single dipole.
- **RegSrc** - regional source.

### 18.6. The BESA Binary Data Format (*.dat)

File containing data associated with generic dataset. Data is written to a floating point binary matrix with the extension ".dat". The matrix has the dimension: `number of samples × number of channels`. The information about number of samples and number of channels is retrieved from the header file (see 18.3). The epochs are written continuously one after the other including the padding interval.

### 18.7. The BESA ERP / ERF ASCII Vectorized File Format (*.avr)

The first of two header lines contains the following data descriptors (7 descriptors, the values shown are only examples):

1. **Npts** = 200: *number of sampled points in each channel.*
2. **TSB** = -500: *time sweep begin [ms]. Time of first data point relative to zero of epoch.*
3. **DI** = 5: *digitization or sampling interval [ms].*
4. **SB** = 1: *default scaling bins/nAm in file.*
5. **SC** = 200: *default scaling calibration.*
6. **Nchan** = 27: *number of channels.*
7. **SegmentName** = 60dB: *an optional label describing the data.*

The second line of the header contains the labels for each channel separated by a blank space. Each of the subsequent **Nchan** lines of the file contains floating point values for all **Npts** time points.

### 18.8. The BESA Connectivity File Format (*.conn)

The file contains connectivity data. The header line contains the following data descriptors (descriptors displayed in **bold**, the values shown are only examples and comments are in *italic)*:

- **VersionNumber** = 1.0: *Version of file format standard*
- **DataType** = Coherence: *Connectivity analysis method*
- **DecompositionType** = Complex Demodulation: *Decomposition type used during time-frequency analysis*
- **ConditionName** = Cond1: *The name of the condition*
- **NumberTrials** = 218: *The number of trials used during analysis*
- **NumberTimeSamples** = 25: *The number of time samples*
- **TimeStartInMS** = -350.0000: *The starting time position – the first available time point in milliseconds*
**IntervallInMS** = 50.0000  The time interval expressed in milliseconds

**NumberFrequencies** = 59  The number of frequencies

**FreqStartInHz** = 2.0000  The starting frequency – the first available frequency in Hertz

**FreqIntervalHz** = 1.0000  The frequency interval expressed in Hertz (only relevant for complex demodulation)

**NumberChannels** = 11  The number of channels

**Frequencies**=4.00;4.47;4.98;…:  The frequencies used (only used for wavelets).

The second row of the header contains the labels of the channels / sources.

The remaining lines contain connectivity data. Data is divided into blocks (2D tables). The number of tables is equal to **NumberChannels** to the power of 2 since every channel is compared with all other channels (including itself, but here all connectivity values are equal to 1). Each block is separated from the next one by an empty line. Each block contains **NumberFrequencies**-rows and **NumberTimeSamples**-columns. The values for each time-frequency entry in the blocks are floating point numbers and are separated by a tab.
19. References


